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1 Introduction 
 
This document is the user manual for USFOS Graphical User Interface, GUI, (file 
name xact.exe). The document describes typical use of the tool, which is a mainly 

a post processor for USFOS, but also offers help in connection with analysis setup 
and run. The manual also explains how to navigate in the graphical user interface, 

what functionality the different buttons and menus contain. It also describes how 
to use the different dialogs that the GUI presents to the user.  
 

The manual is divided into two main chapters: 
 

 Tutorial   : How to utilize the tool? 
 Graphical User Interface : Detailed description of the interface 

 

 

 

Figure 2.1-1  Welcome to USFOS Graphical User Interface  
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2 Getting Started 

2.1 Introduction  
THE GUI replaces the previous USFOS post processor, (XFOS), and could be used 
similar. The GUI is compatible with older USFOS versions, (the current USFOS 

version is 8-2), and will normally handle cases where the simulation “engine” 
(usfos.exe)  and the GUI are running on different computer platforms (f ex USFOS 

running on UNIX and XACT on Windows). The GUI is available on both Windows 
(NT, 2000 and XP) and Linux (RedHat 7.2). The “internal name” of the GUI is 
“xact”, (hence the xact.exe), and this name is referred to (for convenience) in 

some of the following examples.  

2.2 Activating USFOS – Graphical User Interface on Windows 
Computers 

 

Both USFOS and XACT, (as most codes), could be activated in several ways on 
windows computers, from typing commands to “double clicking”. (The “best” 
method is the one preferred by the user).  

 
Starting the Graphical User Interface XACT: 

 “DoubleClick” on shortcut or from the 
Start/Programs menu  
 

 “Double click” on raf file from Explorer. 
 Type xact from a command window 

 
Starting the analysis module: USFOS: 

 Run the analysis module, USFOS from XACT 

 Type usfos from a command window 
 Execute USFOS from script file(s) 

 
It should be noted that the default directory in XACT (the directory where XACT 
will search for and save files) is depending on start method, see Table 2.2-1: 

 

Start Method Default Directory 

Shortcut/start menu USFOS example folder, (typical  
C:\Program Files\USFOS\examples) 

From Explorer The directory where the raf file is located.  

Typing from command window “Current directory” of the actual command 
window, (f ex where the USFOS files are 

located). 

Table 2.2-1 Default Directory vs. Start Method on Windows  

In order to avoid tedious “browsing” to the correct directory, it is recommended 

to start both USFOS and XACT from the directory where the USFOS files are located. 
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2.3 Activating USFOS – XACT on Linux computers 

 
On UNIX (Linux is a UNIX dialect), programs are executed by typing it’s name in 

a command window, (the PATH variable is updated during installation).  
 
Startingteh Graphicla User Interface  XACT: 

 

 Type xact from a command window 

 
Startin the naalysis module: USFOS: 

 

 Run USFOS from XACT 
 Type usfos from a command window 

 Execute USFOS from script file(s) 
 
The default directory in XACT (the directory where XACT will search for and save 

files) is “Current directory” of the actual command window, (f ex where the 
USFOS files are located). 

 
In order to avoid tedious “browsing” to the correct directory, it is recommended 
to start both USFOS and XACT from the directory where the USFOS files are located. 
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3 Tutorial 
 

3.1 Introduction 

 
Typical use of USFOS-XACT will be described in the following without explaining 

how to operate the different menus/buttons, (Description of the interface is given 
in Graphical User Interface section).  
 

The examples should give the user a brief overview of the possibilities, and does 
not cover all available functions. It is therefore recommended to take a look in the 

Graphical User Interface section of this manual.  
 
USFOS-XACT has identical behavior on Windows and Linux.1 

 

3.2 What is XACT? 

 
XACT is the graphical User interface for USFOS with following main functions: 

 
 Preparing USFOS analysis input 
 Starting USFOS analysis 

 Inspecting USFOS analysis results 
 

3.3 Preparing USFOS input Files 

 

3.3.1 Introduction 

 
XACT offers input preparation aids for USFOS: 

 
 Visualization of the structural model in advance of the analysis  
 “Wizard” for first time users for creation of a minimum input file  

 Specialized USFOS editor, (context sensitive) 
 Communication between the 3D graphical image and the USFOS editor in 

connection with selection of nodes and elements.  
 Testing the input by running directly from the Analysis Control Center.  

 

 

                                                 
1
 This is not the case for USFOS release 8-3/ USFOS GUI version 2.3, where USFOS GUI 

version 2.3 is available for W indows only 
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3.3.2 Opening of Analysis Model 
 

If the complete structural model is collected in one file, it could be opened and 
displayed prior to the analysis. Node- and element numbers are available in the 

3D image, which will ease the further USFOS model setup. 
 
Use “Open USFOS Model File” located under the File menu, see Figure 3.3-1. The 

File open dialogue box appears (Figure 3.3-2), and files with extension .fem will 
be displayed. In this demo example, the file t1.fem is selected. 

 

 

 

Figure 3.3-1  Open USFOS  Model File  

 
 

 

Figure 3.3-2  Open Model File Dialogue box 

 

 
If the model file is complete, (and correct), the 3D image of the model will appear 
without any results available, see Figure 3.3-3. In this mode, following options 

are available: 
 

 Hide/Show Groups (ref to set in SESAM) 

 Node and Element number visualization, (On/off switches under Verify)  
 Verification of Node coordinates and boundary conditions 

(Verify/Verification) 
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Figure 3.3-3  Successfully Opening of Model File  

 

 

3.3.3 Analysis Setup, (Wizard). 

 
When an input is modeled from scratch, the “Wizard” could give some help in 
connection with defining the mandatory (minimum) input for the analysis. Under 

Analysis on the menu bar, the “USFOS Analysis Setup” is selected. 
 

 

 
 

Figure 3.3-4  Analysis Setup / Analysis Control  

 
Three different “sheets” are available: 

 Static analysis setup 

 Cyclic analysis setup 
 Dynamic analysis setup 

 
The different choices are shown on the tabs on the upper left corner of the setup 
sheet, (see Figure 3.3-5 for static analysis setup sheet and Figure 3.3-6 for 

dynamic analysis setup). 
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Figure 3.3-5  Setup sheet for static analysis. Empty 

 

 

 
 
Figure 3.3-6  Setup sheet for dynamic analysis. Empty 
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The use of the Wizard is demonstrated in the following: 

 
Header: 

Up to three lines of text to identify the analysis. The heading will appear on the 
result output. 
 

Control Node: 

Selection of a Node/Dof to monitor during the analysis. This displacement is the 

“Global Displacement”, and is the X-axis in the global Force-Displacement plot, 
which appears automatically when a USFOS result file is opened.  
 

The node is selected either by typing in the Node ID or by pointing on the 3D 
Image of the structure. (Press the target button, and use ctrl+left mouse button to 

select). The actual degree of freedom, (typically the direction of the main 
loading), to monitor has to be specified.  
 

Loading sequence: 

The actual load cases to apply, (in a specific sequence) are defined by selection of 

load case ID, scaling factor per step and maximum load. Available load cases, 
(found on the model file), are listed.  
 

Select load case, type in load increment, max load and add to list.  
 

 

Figure 3.3-7  Setup sheet for static analysis. Completed 

 

Available Load Cases 

Saving/Loading of 

Sheet parameters 

Generate USFOS input 

file when sheet is 

complete. 
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It is possible to save the sheet parameters, and the file extension is .uss, (USFOS 
Setup file), using the Save button, see Figure 3.3-8. This setup file could be 

loaded and for example used as a starting point for later analyses, (Figure 3.3-9). 
 

 

Figure 3.3-8  Saving of Setup Sheet Parameters  

 

 

 
 

Figure 3.3-9  Loading parameters for Setup sheet 

 
 

 

 
As the different items are correctly filled in, the actual check box gets a green tag. 

When the sheet is completely filled in, the apply button becomes active.  
 
When the APPLY button is activated, the Sheet parameters are translated to 

USFOS commands, and the commands appear in the control file window of the 
“Analysis Control” dialogue box, (see  3.3.4). 
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3.3.4 Analysis Control, (Editor and Control Center). 

 
With the automatically created USFOS control file, Figure 3.3-10, the model is 

ready for the analysis, (just press the “run” button). Output from the analysis 
module appears in the lower window, Figure 3.3-11. 
 

Figure 3.3-10  Analysis Control automatically filled in by the Wizard 

 

Figure 3.3-11  Running USFOS  from the Analysis Control  

 

Further commands to USFOS have to be written 100% manually in the “USFOS 
editor”, (other text editors could also be used), or semi automatic utilizing the command 

menu selection. One example of use of the latter is given below: 

USFOS commands, 

translated from 

the setup sheet 

Running the 

analysis module. 

Output from the 

analysis module. 
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By pressing the function key F2, the main command headlines appear, Figure 
3.3-12. In this example, the “Joint Modeling” is selected, and all available USFOS 

commands for joints appear, Figure 3.3-13. The Joint Capacity Check is selected, 
and the actual USFOS command is automatically inserted in the control file (Figure 

3.3-14) ready for specification of the actual joint (node ID) and the two chord 
members. The parameters are either typed in directly or selected from the 3D 
image by just pointing, (ctrl + left mouse button), at the node and elements, see 

Figure 3.3-15. Note that by pressing the F1 key when the cursor is in a line 
starting with an USFOS command, the parameter description is inserted as a 

comment line above the line containing the command. 
 

 

Figure 3.3-12  Adding USFOS commands. Selection from the command menu, (F2  key)  

 

 

Figure 3.3-13 Selection of Joint Modeling Command: CHJOINT 

 

Figure 3.3-14  Automatic inserting of the CHJOINT Command in the USFOS editor. 

USFOS command, (with parameter 

description), automatically inserted 
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Figure 3.3-15 shows an image of the structure with node- and element ID’s 
applied and how the ID’s are automatically filled into the control file.  

 
If USFOS is analyzed with this joint option applied, restriction on load transfer 
between brace and chord is set automatically. Figure 3.3-16 shows the model 

with the joint transfer elements automatically inserted, and the utilization of the 
different components (image to the right). In this case, the red color of the joint 

transfer elements indicates that the connection is weaker than the brace itself for 
the actual loading situation. 
 

Figure 3.3-15  Selecting node and element ID’s by pointing on the 3D image. 

 

Figure 3.3-16  USFOS analysis with Joint Resistance Limitation applied.  

 
 

Joint Transfer Elements 

automatically inserted 
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3.4 Post Processor 
 

In the examples below, it is assumed that USFOS has been run, and that USFOS 
result file (the “raf” file) exists. 

 

3.4.1 Checking USFOS analysis model 

 
In order to verify that the analysis model is correct, it is recommended to inspect 
the properties graphically. In Figure 3.4-1, the available verification items are 

shown in the results dialogue box, and in the example, the marine growth is 
visualized with colors. Similar images are available for: 

 
 Wall thickness  (see Figure 3.4-2, left) 
 Yield Stress  (both initial and eventually degraded) 

 E-mod  (both initial and eventually degraded) 
 Mass distribution (Density of material multiplied by wall thickness) 

 Hydrodynamic Drag- and Mass Coefficients 
 Flooded Elements  (Flooded members are red, see Figure 3.4-2, right) 
 Buoyancy Diameter (Flooded members become blue, and the air filled 

member with largest diameter become red. If history dependent buoyancy 
is used, the buoyancy at current load step (time) is visualized) 

 
 

Figure 3.4-1  Visualizing the Marine Growth on the individual members.  
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Figure 3.4-2  Visualizing the Wall thickness  (left)  and Flooded Members (right) 

 
Detailed information of the model is given using the “Verify/Verification” option, 

and in Figure 3.4-3, node and element information is presented. If the model 
contains a foundation model, key information about the soil properties are 

presented by pointing on actual soil disc elements. (If the element(s) in question 
are hidden, use the clip command, f ex “pick and remove element”).  
 

Figure 3.4-3  Print of Node- and Element Information. 
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3.4.2 Inspecting USFOS results 

 
In the following, results from a typical jacket “push over” analysis are presented.  

In Figure 3.4-4, the USFOS response curve (Global displacement vs Global Load) 
is by default presented in the plot. By default, the deformed shape is visualized 
with displacement scaling factor=1.0, (could be modified by the user).  

 

 

Figure 3.4-4  Jacket “Push Over” Analysis Results 

 

A “Snapshot” of the plastic utilization of the structural members for the final step 
(note the red cross in the curve, which indicates the actual load step) is visualized 
in the image window. (Actual Load Case/Step is printed in the image window). 

To select an analysis step to inspect, either point on the curve at actual state, or 
step forward/backwards using the slide or the up/down arrows.  

 
If a foundation model (piles or spud can) is included in the simulation, the 
utilization of the soil is presented together with the structural model, see Figure 

3.4-5. 
 



USFOS Graphical User Interface 2.6  21 

User’s Manual 

 
 

Figure 3.4-5  Plastic Utilization of structure and pile/soil foundation  

 

In order to get a better overview of the individual components of a complex 
jacket structure, the clipping function (see Clip… ), will together with the 

Element Numbers ease the documentation of the analysis, (see Figure 3.4-6). 
 

 

Figure 3.4-6  Visualization of the utilization of one Row with element numbers applied.  
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In Figure 3.4-7, plot of the axial force of one member, (element 2402, which has 

buckled) is included, and it should be noted that the red cross in the main plot 
window (upper left corner of the interface) and all history plots are synchronized 

helping the user to interpret the analysis results. Any history plot could be used 
for selecting of actual load step to inspect, and an “unlimited” number of history 
plots could be defined, (“New Plot” gives a new plot, while “Update Plot” 

updates the current active plot).  
 

 

 
 

Figure 3.4-7  Visualization of the utilization of one Row with element numbers applied.  
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3.4.3 Extract Results for documentation. Images 

 
Images contain valuable information. As structural analyses typically are 

documented in written reports, the transfer of data from the User Interface to the  
Word Processor is important for the user’s efficiency. If a general image tool is 
available, it is always possible to “grab” any image from the screen (as used for 

this document), but its also possible to save the images directly from the interface. 
Several file formats are available (tif, gif, bmp …), and the screen resolution 

(default is 480 x 640) could be modified by the user.  
 
In addition to use the menu, it is possible to access the “Save scene to image” 

using short key.  

Figure 3.4-8  “Save Scene to Image” with default resolution 

 
Some time saving hints: 

 
 Use Ctrl M to get the dialogue box 
 The interface “remembers” last used image format 

 Default file names are suggested, and the name is automatic incremented, 
(first image gets “image0.gif”, next get “image1,gif”, etc)  

 Hit return to save. 
 
This means that by typing: Ctrl M followed by C/R C/R saves the image on the 

default directory  (NOTE that default directory is dependent on start method, see 
page 7). 

 
 



USFOS Graphical User Interface 2.6  24 

User’s Manual 

 

3.4.4 Extract Results for documentation. Curves 

 
In addition to images, 2D curves contain valuable information, and the user may 

need the plot information for different purposes. The available options are:  
 

 Print (default printer) 

 Copy (send to clipboard for import in f ex Word or Powerpoint) 
 Save plot as a file (bmp format) 

 Copy the plot data into f ex Word, Excel etc 
 Save the plot data on a file.  

 

Figure 3.4-9 shows the history plot together with the plot data. Axis labels are 
written on the top. 

 

Figure 3.4-9 History plot                     and                      the plot data 

 
Similar to the saving of images, several short keys exist for fast import to f ex 

Word: 
 

 Define plot 

 Press ctrl c 
 Activate Word and “paste” (ctrl v) 

 
Unfortunately, some word processors (f ex Word) will auto scale the plot, (small 
plots become bigger), and it is therefore necessary to adjust the plot size manually 

after import to obtain same size on paper as in the graphical user interface.  
 

# 

#Global displacement 

#Global load 

0.00438014 1 

0.0131412 3 

0.0210948 4.8153 

0.021916 5 

0.0226429 5.15826 

0.0229894 5.23253 

0.0231462 5.26578 
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3.4.5 Extract Results for documentation. Facts (text) 
 

In addition to images and plots, facts are required in the documentation of an 
analysis. Some facts are available from the User Interface, and this type of 
information is organized under “Verify/Verification Info”.   

 
Most of the items are dependent on the load step, and results for the current step 

are printed, (The Print is not automatically updated if another step is selected).  
 

Figure 3.4-10 Verification Info and print of Base Shear etc for a given load step.  

 

 

Figure 3.4-11 Print of Structural Mass and Reaction Forces .  

 

The information in the “Verification Info Window” could be selected and 
imported to f ex Word (mark the actual information using left mouse button, and 

use the right to copy). 
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3.4.6 Extract Results for documentation. Hydrodynamics. 

 
If a dynamic wave analysis has been performed in USFOS, plots of wave 

kinematics could be generated. The user selects where (in the X-Y space) 
kinematics should be calculated, and a depth profile of actual wave kinematics 
component (either Acceleration or Velocity, X- Y- or Z- component) is generated. 

The user defines the X-Y position by pointing at a node on the structure.  
 

In Figure 3.4-12, two depth profiles are selected, one at the left hand side of the 
jacket, and one at the right. As seen from the wave surface position, the right 
hand side of the platform has approx. maximum velocity while the left hand side 

is between max and min. Eventually current profile is included in the velocity 
profile. Zero on the vertical axis is the MWL, and minimum Z-value is the depth 

specified in the USFOS Wave Data input. 
 

 

Figure 3.4-12 Plot of Wave Kinematics at different positions on the Jacket. .  
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4 Graphical User Interface 
 

4.1 Introduction 

 
This chapter describes the graphical user interface  and the functionality of 

USFOS/Xact. It is a walkthrough of the contents in the user interface, which 
includes the main window with the docking windows it may contain, menus in 
the menu bar, the toolbar, and a number of dialogs that are available through the 

menus and toolbars. 
 

4.2 Main Window 
 

When Xact is started, the main window will be empty, and only a few actions are 
available for the user. The rest of the actions will become available when an 
analysis is opened. Some actions may still be unavailable after you have opened 

an analysis file if the file does not contain data to complete the action. I.e. if you 
have an analysis with no eigenmodes, the eigenmodes button will not be 

available.  
 
Once a raf- file is loaded, the graphics window will show the model. On the left 

side are two dockable windows. The top window is the main control plot. The 
lower window is the result and groups window.  
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4.2.1 Control Plot 
 

 

The main plot window will show the default plot for the analysis. Once a model is 
opened, you can set the load step from this plot window. There are several ways 

to set the load step. Either by clicking on the point in the plot you want to go to, 
by dragging the bottom slider, or by using the spin box in the lower right corner. 
Read more about plots in the “Plots” chapter.  

4.2.2 Results/Groups/Parts window 
The results/groups/parts window will show 

what results are on the current analysis and able 
you to choose what result to show.  

4.2.2.1 Results Tab 

All results are organized in a tree view. If you 
double click a result, the graphical window will 

immediately be updated to show the result on 
the model. A fringe range will automatically be 
set to fit the result. Results can also be applied 

by moving the blue selection up and down in 
the list and pressing enter. 

4.2.2.2 Groups Tab 

If any predefined groups are available for the 
analysis, they will turn up in this list. To show a 

group, just right click on it and pick “Show 
selected groups”, from the menu that pops up. 

To display several groups, select what groups 
you want to show, right click them, and select 
“Show selected groups”. All selected groups 

will be displayed in addition to groups already 
displayed. To hide groups, just right click in the 

group tab, and choose “Hide selected groups”. This hides all groups you had 
selected. 
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With no selection you can also right click and choose “Show all groups”, “Hide 
all groups” and “Show complete model”. 

The “Highlight selected groups” checkbox at the bottom is checked by default, 
which means that the currently selected groups are highlighted in the graphics 

window. The elements of the highlighted groups are drawn in magenta color.  

4.2.2.3 Parts Tab 

The parts tab contains a list of the parts in the model. Each part name has a check 

box on the left side. Checked part names indicate that the corresponding part is 
visible, and an unchecked check box means that the part is hidden. The following 

picture shows and example with two parts: 
 

 
 

One or more parts can be selected at once (use the Ctrl or Shift button while 
selecting). The “Show” and “Hide” buttons show and hide all currently selected 

parts, respectively. “Select All” selects all parts, while “Clear Selection” deselects 
all parts. 

4.2.3 Command Window 

All menu commands can be accessed directly by using the command window. For 
a complete command index, see Appendix 1. When you start up Xact, the 

command window will be hidden. To display it go to the Window menu and 
choose “Command Window” 

4.2.4 The Toolbar 

If you right click anywhere on the toolbar, a menu will pop up,. The menu shows 
all the windows in the application. Windows that are currently displayed in the 

application is shown with a small check sign on the left. All toolbars in the 
application is also listed, and if they are displayed, they too will have a small 
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check sign to the left. If you want to hide a plot, window or toolbar just click on it 
in this menu, and it will be hidden from the application. To bring it back again, 

right click the toolbar again to bring up the menu, and check the windows you 
want to display. 

In the menu below we see that a number of plots has been created and that they 
all are displayed. We also see that the command window is not shown in the 
application, and that all toolbars are displayed.  

 

4.2.5 Navigating in the Graphics Window 
You can rotate, zoom and pan the model in the graphics window.  
Pan – To pan the model, press the left mouse button and drag the mouse in the 

direction you want the model moved. Your cursor will change to a hand when 
you left-click in the graphics window. 

Zoom - To zoom the model, press both left and right button and drag the mouse 
towards you to zoom in, and push it away to zoom out. The cursor will change to 
an arrow pointing inwards the screen when you zoom.  

Rotate – Press and hold the right mouse button to rotate the model. Your cursor 
will change, and when you move the mouse the model will rotate accordingly. It 

may take a bit of practice to get used to how the rotate function behaves.  
 
In addition to these navigational functions there is a toolbar with functions for 

stepwise rotation, and a “navigation cube” for navigation to specific views.  This 
will be explained later. 
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4.2.6 Picking 
You can pick one element by holding down CTRL and left clicking an element 

with your mouse. Element number, closest Node, and End will be displayed for 
the picked element. The picked element will also be colored light blue. To clear 

any picking, hold CTRL key down and left click on an empty space on the 
graphics window.  

4.2.7 Plots 

There are four different plot-types in Xact: History Plots, Dynamic Plots, Material 
Model Plots and Verification Plots. 

All plots have some common features. By right clicking in the plot, you will bring 
up a menu. From this menu, you can print the plot, copy it to the clipboard, export 

it to a image file, copy it as text to the clipboard (pairs of x and y-values), save 
the x and y values to a text file and you can destroy the plot. When you destroy a 
plot it will be removed from the application. It cannot be retrieved from the 

menu-bar. 

4.2.7.1 History Plots 

All history plots can control what load step you want to display. Load step can be 
selected by clicking in the plot on the point you want to display, by dragging the 
slider at the bottom, by increasing or decreasing the value in the spin box, or by 

typing a value in the box.  

4.2.7.2 Dynamic Plots 

Dynamic plots show data that are the same for all steps. No interaction is possible 
with dynamic plots. 

4.2.7.3 Material Model Plots 

Material Model Plots show a different plot for each step. When you change load 
step via a history plot, the data in the material plot will be updated accordingly.  

4.2.7.4 Verification Plots 

Verification Plots act in the same way as Material Model Plots. The plots are 
updated when the load step is changed.  

4.2.7.5 Current Plot 

There are two types of current plots. For all four plot-types there exists a current 
plot. A current History Plot, A current, Material Plot and so forth. In addition 

there is a current plot for all types. That plot is always the last one selected. You 
can se what plot is the current plot for all types by looking at the plot title. The 

plot title of such a plot, will have CURRENT written in capital letters.  
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4.2.8 The USFOS Editor 
The application has an internal text editor. You may open any ASCII text file in 

this editor and edit it (see sections 4.3.3 and 4.3.4), even though it is originally 
meant for USFOS input files (see section 4.8.2). 

 
The editor does syntax highlighting of USFOS commands, comments and 
command parameters, has a command browser, and performs automatic insertion 

of element and node IDs as command parameters by CTRL + left mouse button 
clicks in the 3D model. See section 3.3.4 for a brief description of how to use the 

editor, illustrated with an example. A more detailed description is given here. 
 
The USFOS editor looks like illustrated in the following figure: 

 

 
 
The USFOS editor uses syntax highlighting. If a line starts with a word that is 
recognized as an USFOS command, the word is written in blue color. Comments 

are written in green color and all other text, which should be command 
parameters, is written in black color.  

 
The editor has a “File” menu, an “Edit” menu, and a “Window” menu. The items 
in the “File” menu are: 

 
New: 

Create a new file. 
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Open: 

Open an existing file. 

 
Save: 

Save the current file. 
 

Save As…: 

Save the current file to a given filename.  
 

Close: 

Closes the current file. 
 

Close Editor: 

Closes the editor. 

 
The “Edit” menu has an item called “Find…” which lets you search for a text 
string and highlight it if found. “Find Again” repeats the last search.  

 
The “Window” menu contains an item for each file being open in the editor and 

lets you switch between the different files.  
 
The editor gives you help in writing commands. By pressing the F1 key when the 

text cursor is in a line starting with an USFOS command, the parameter 
description is inserted as a comment line above the line containing the command.  

 
If you press the F2 key, 
the “command browser” 

appears. The command 
browser contains a list of 

the command categories. 
You may select a 
category by using the 

up/down arrow keys and 
pressing the RETURN 

key, or by double-
clicking a category in the 
list with the left mouse 

button key.  
 

When a category is 
selected, the command 
browser shows a list of 

the commands in the 
category. To get back to 

the category list, just 
press the BACKSPACE 
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key. A command is selected the same way as you select a category.  
 

When a command is 
selected, the command 

browser disappears and 
the command is inserted 
in the file you are editing. 

One or more comment 
lines with parameter 

descriptions will be 
inserted automatically 
above the line containing 

the command. Note that 
the command browser 

may be closed at any time 
by pressing the ESC key.  
 

A lot of the USFOS commands have node IDs or element IDs as parameters. 
Those may be written manually of course, but you may also insert them by 

pressing the CTRL button and clicking the left mouse button while pointing in the 
3D model. This will only work if the text cursor is located in a line containing a 
command (or a following line with parameters) and the next expected parameter 

is a node ID or an element ID. Also note that the USFOS editors in the Analysis 
Control Dialog (see section 4.8.2) have priority over this editor. This means that 

the node ID or element ID will be inserted in the currently active editor in the 
Analysis Control Dialog if the dialog is visible and the next parameter to be 
written is a node ID or an element ID. 

 

4.3 The File Menu 

4.3.1 Open USFOS Result File… 
Shows a file dialog where you can browse to .raf- files that can be opened in Xact. 
Once a raf- file is opened, the graphics window will be updated to show the 

model, and the control plot and result/group window will contain relevant data 
from the analysis. 

4.3.2 Open USFOS Model File… 
Opens a file dialog from which model files may be opened. Once a model file has 

been opened successfully, the graphics window will be updated to show the 
model. The control plot and the result/group window will be empty since  a model 
file contains only the model, not any results. Xact is able to read structural files 

supported by USFOS (SESAM and UFO).  
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4.3.3 Open Text File… 
Opens a file dialog for selection of files to be opened as text files. Any file can be 

opened here, and is displayed in the internal text editor when it has been opened. 
Multiple files can be open simultaneously, and the Window menu of the editor 

lets you select the file you want to edit.  

4.3.4 New Text File… 

Displays the internal editor and creates a new file ready for editing. 

4.3.5 Load View Attributes… 
Enables users to load view attributes from an USFOS Attribute File (.usa). For 

convenience the default file that pops up in the file dialog is usfos.usa. View 
attributes can be saved with the “Save view attributes” action.  

4.3.6 Save View Attributes… 
Saves a view attribute file to disk. This file contains the rotation and viewpoint 
you have in your graphics view at the moment. You can save your current view, 

and load it later. The view attribute file is global, so it can be used for other 
models as well as the one you saved it with. By default the name for the saved 

view attribute file is usfos.usa. This name can be changed at the users 
convenience. 

4.3.7 Preferences… 

Opens the preferences dialog, which contains two tab windows: “Settings To 
Keep On New File”, and “Plot Settings”. The former is used to select settings to 

keep when a new file is opened, which may be useful for comparison of the 
outputs of different analysis runs. There’s also a check box for toggling of this 
functionality: 
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The “Plot Settings” tab has a check box that can enable usage of the size of the 

last plot that was created when a new plot is created: 
 

 

 
 

4.3.8 Run Utility 

This sub menu is available only if a configuration file named “Xact_Utils.usc” 
was present in the same directory as the USFOS GUI executable when it was 

launched, and if the file actually contained valid information about available 
utilities. The sub menu contains the names of the utilities according to the 
specification found in the configuration file. A “run utility dialog” is opened if 

one of the utilities is selected. The dialog presents the standard output from the 
utility and lets you give standard input to it. The utility is launched when the 

“Run” buttons is pressed, starting with the given parameters. The following figure 
shows what it looks like when StruMan is launched from this menu.  
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The “Output” window on top shows the standard output and the “Standard input” 

control lets you type standard input. Standard input is given to the utility when 
RETURN is pressed or when the “Apply” button is clicked. Note that the 
“Browse…” button lets you select a filename from a file dialog. The filename is 

appended to the current text in the “Standard input” control. The “Abort” button 
terminates the current run and the utility is launched again if you click the “Run” 

button. The “Close” button closes the dialog. See Appendix B for a description of 
the format of the configuration file “Xact_Utils.usc”.  

4.3.9 Utilities… 

This menu item is available only if a configuration file named “Xact_Utils.usc” 
was present in the same directory as the USFOS GUI executable when it was 

launched, and if the file actually contained valid information about available 
utilities. The menu item opens a dialog that may look like the following figure.  
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The list on the left side shows the names of the available utilities as defined in the 
configuration file. When a utility is selected, a description of the utility is shown 

on the right side of the dialog if a description is given in the configuration file. A 
hyperlink to a manual for the utility is given after the description, if present. The 

manual file will be launched if the hyperlink is clicked. This will work only if the 
manual’s file type (typically .pdf, .html, or .txt) is associated with an application 
that is able to read it. 

 
The “Run” button launches the selected utility, which will be run through a 

dialog. This is analog to launching a utility through the“Run Utility” sub menu. 
See previous section. See Appendix B for a description of the format of the 
configuration file “Xact_Utils.usc”.  

4.3.10 Read Labels From File… 
Opens a file dialog where you may select and open an USFOS Label File (.usl). 

This file type is an ASCII text file containing user-defined labels for nodes and/or 
elements. This is useful if you want to add textual information to specific parts of 
the model. User-defined labels are attached to nodes or elements in the 3D model. 

A dialog will appear when a file containing labels has been loaded successfully. 
The next section describes this dialog. See Appendix B for a description of the 

USFOS Label File Format. 

4.3.11 Labels… 

This menu item is disabled unless you have read a valid USFOS Label File (.usl) 
(see previous section). The menu item opens a dialog as shown in the following 
figure. 

 

 
 
The dialog contains a list of the label group names. A label group is selected by 

pointing at its name and clicking it, or by using the arrow up/down buttons. 
“Show Labels” shows the selected group of labels. To show more than one group 

of labels simultaneously, click the “Add Labels” button. “Clear Labels” will 
remove all user-defined labels from the 3D view. The “Close” button closes the 
dialog. 

 
Note that you may manipulate visible user-defined labels in the 3D graphics 

window. If you click the right mouse button within the window, a popup menu 
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will appear. Selection of the menu item “Attach all labels to 2D view” will make 
all visible user-defined labels “float in 2D”. This means that the labels are not 

attached to nodes or elements any more and will not follow the model when you 
navigate in the 3D graphics window. Lines are drawn from the labels to the nodes 

or elements the labels belong to, as shown in the following figure.  
 

 
 

Selection of the menu item “Reattach all labels to 3D model” will reattach all 
visible and floating user-defined labels to the 3D model.  

 
Labels that are floating in the 2D view may be moved by moving the mouse while 
pressing the Ctrl key and clicking and holding down the left mouse button.  

 
Also note that you may manipulate the user-defined labels individually by 

pressing the Ctrl key while right-clicking the node or element a label belongs to. 
This will bring up a context menu saying “Attach label to 2D view” or “Reattach 
label to 3D model”. Selection of one of those brings up another level in the menu 

conaining the label text, and selection of this item will perform the action.  

4.3.12 Export to GLview Pro… 

Exports the current model and its states to a VTF-file. This file can be opened 
with GLview Pro from Ceetron for further post-processing (see 
http://www.ceetron.com). You can choose to export the current state/load step, or 

to export all available states.  

http://www.ceetron.com/
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4.3.13 Export to Image… 
Saves the current view as a picture. The first dialog lets you set the resolution for 

the picture. Once you have set the right resolution, you will be able to choose a 
filename and format for the picture. Current supported formats are; .tif, .bmp, .gif, 

.eps, .ppm, or .rgb. Note that if a region has been selected, the region will specify 
the area that is exported as an image to file. See also 4.3.15. 

4.3.14 Print… 

Print Scene – Prints the model as it’s seen on the screen. First dialog lets you set 
the resolution of the print, and the second one lets you choose a printer.  

Print Plot – Prints CURRENT plot. See Plots on definition on CURRENT plot.  

4.3.15 Select  Region 

When this menu item is selected, clicking and dragging inside the graphics 
window lets you select an area (a rectangle). This area specifies the area that is 
exported when an image is exported (see 4.3.13). No selected region means that 

the entire view is exported. 

4.3.16 Recently Opened Files 

After the print item in the file menu a list of the four last opened models will 
appear. If you are using Xact for the first time, this list will be empty.  

4.3.17 Xit Xact 

Closes the current raf- file, and exits Xact. 
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4.4 The Edit Menu 

4.4.1 Clip… 
The clip action brings up the clip dialog. From there you can start clipping your 

model. The cursor takes the form of a pair of scissors to show that you are in clip-
mode. To clip the model, simply press and hold the left mouse button. A line is 

drawn, and depending on what clip mode you are in, the model will be cut on 
either left, right, top or bottom of the line that you drew. You can change clip 
mode at any time.  

If you choose pick and remove 
element, you will enter a clip mode 

where you can clip one and one 
element of the model. Hold down the 
Ctrl-key on your keyboard while 

clicking on the element you want to 
remove. The element will be 

removed from the model. If you 
removed the wrong element, click 
“Undo” in the clip dialog.  You can 

only undo one step back.  
The “Complement” button shows all 

parts that are clipped. When you press the “Complement” button, the text on it 
will change to “Clipped”. If you press the button now, it will show the original 
clipped model. 

Pressing the “Reset” button resets all clipping. All parts are made visible. The 
complete model is shown. 
You exit the clip mode by closing the clip dialog.  

4.4.2 Clip Left 
Lets you do a one shot clip. Press and hold the left mouse button and drag the 

mouse. A line will be drawn up. When you release the mouse button, everything 
on the left side of the line will be cut.  

4.4.3 Clip Right 
Same as Clip Left but clips everything on the right side of the line.  

4.4.4 Clip Top 

Same as Clip Left but clips everything over the line.  

4.4.5 Clip Bottom 

Same as Clip Left but clips everything under the line.  
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4.4.6 Show Clipped 
Shows the clipped model. If you have no clipped model, this choice will be 

grayed out. 

4.4.7 Show Complement 

Shows the complement of the clipped model. If you have no clipped model, this 
choice will be unavailable 

4.4.8 Reset Clipping 
Resets the clipping and shows the complete model.  

4.5 The Display Menu 

 

4.5.1 Show as Surface 

Updates the view to show the model with a solid surface. This is the standard 
display mode. 

4.5.2 Show as Lines 
Model in view is show as lines/grid 

4.5.3 Show as Points 

The model is represented with a number of points at element ends.  

4.5.4 Show as Hidden Lines 

Same as “show as lines” but lines behind elements are hidden.  

4.5.5 Mesh 

Displays a mesh over the model, if you are looking at it in “show as surface” 
mode. 

4.5.6 Show Legend 

Toggles display of a the legend. The legend shows the colors and names of the 
parts the model comsists of, unless a scalar result has been selected and display of 

fringes is turned on. In the latter case the legend will show how the model is 
colored according to the result. 

4.5.7 Show Navigation Cube  

Toggles display of a “navigation cube” in the lower left corner of the graphics 
view. Clicking on the faces, edges or corners of the cube or the arrow symbols 

surrounding the cube navigates the model to special views, typically so that the 
view direction is parallel with one of the coordinate system axes.  



USFOS Graphical User Interface 2.6  43 

User’s Manual 

4.5.8 Color Settings… 
Brings up a dialog that lets you choose what colors to use for your view. Click on 

the colored field under Background, 
Mesh or Model to bring up a color 

picker one of them. Once the desired 
color is picked and you exit the color 
picker, you can press “Apply” to apply 

the new colors.  
The “Save” button stores away the 

currently applied colors to the registry, 
and uses these colors to draw the 
current and future models.  

If you want to restore the colors to the 
default USFOS/Xact colors, just press the “Default” button, and “Apply” 

thescolors to the model. 
 

4.5.9 Part Attributes… 

Brings up a dialog that lets you change the visibility, color, and transparency of 
parts. It looks as shown in the following figure.  

 
 
The parts are listed in the list to the left. The controls will manipulate the 

currently selected part. Clicking the “Visible” check box will show or hide the 
part, the “Color:” button brings up a dialog for selection of part color, the 
“Transparent:” check box turns on or off the transparency of the part, and the 

transparency slider control sets the transparency of the part. This is a value from 0 
to 255, where 255 means total transparency. Clicking the “Apply” button will 
apply the current settings. You don’t have to click this button if “Auto Apply” is 

checked. “Close” will close the dialog.  
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4.6 The Verify Menu 

4.6.1 Node Numbers 

Turns the display of node numbers on/off 

4.6.2 Element Numbers 

Turns display of element numbers on/off 

4.6.3 Highlight Node… 

Opens a dialog for highlighting of nodes. It contains a list of all nodes and the 
node selected in the list is highlighted by clicking the “Highlight” button or by 
pressing the RETURN key. The node ID may be typed in manually as well. If 

“Auto Highlight” is checked, a node is highlighted as the node selection changes 
(by pointing and clicking using the mouse or by using the arrow up/down keys in 

the node list). The dialog is shown in the following figure.  

 
 

4.6.4 Highlight Element… 

Opens a dialog for highlighting of elements. It contains a list of all elements and 
the element selected in the list is highlighted by clicking the “Highlight” button or 

by pressing the RETURN key. The element ID may be typed in manually as well. 
If “Auto Highlight” is checked, an element is highlighted as the element selection 

changes (by pointing and clicking using the mouse or by using the arrow up/down 
keys in the element list). The following figure shows what this dialog looks like.  
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4.6.5 Vectors 

Toggles display of vectors. The menu item is disabled unless a vector result or 
boundary condition like nodal forces has been selected. 

4.6.6 Vector Settings… 

This menu item is enabled when a vector result is selected in the “Results tab 
window”, and selecting it will open a dialog for settings of the selected vector 

result. Vectors are drawn as arrows with or without arrow heads with a given 
scaling factor, absolute or relative to the model’s extent. This dialog also lets you 
set the color and line thickness of the vectors. It is also possible to apply a filter 

so that only vectors with lengths within a given range are visible. The vector 
settings dialog looks as shown in the following figure.  
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4.6.7 Info Window… 
Displays the Info Dialog box. This box will be filled with information when you 

use the Verification dialog explained next. The text in the info dialog can be cut 
out, if you want to use it in other applications or reports.  

4.6.8 Verification… 

 
 

The verification dialog lets you retrieve information about the model. All info is 
printed in the Info Dialog.  
The dialog is split into two parts: one for General Verification info and one for 

node/element- info. 
 

If any general verification info is available on the opened file, it will show up in 
the available info- list. Some information might require additional input, like a 
element ID, End and DOF. This information can be typed in by hand, or picked 

directly from the model. To pick an element or node, push the “pick” button. It 
will be toggled and you can do a regular pick on the model (CTRL + Left mouse 

click). The Element/node ID and End will be filled out automatically from the 
pick. If you press “Apply”, the information for the picked node/element will 
appear in the Info Dialog. If the info dialog isn’t visible on the screen, it will 

automatically pop up when you do this.  
 

The Node/element info has two checkboxes. If you check the Node Info box, the 
Info Dialog will display info about nodes when you do picking in your model. 
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Checking the Element box will do the same for elements. When you close the 
verification dialog, no info will pop up in the Info Dialog when you do picking.  

4.6.9 Verification Plot… 

 
 

Brings up a dialog that lets you create a verification plot. A list of available plots 
is shown. In addition to what plot you want to show, you have to choose what 

node you want to show it for, and the DOF for the x-axis.  
Update Plot updates the current verification plot. If you haven’t made any 
verification plots yet, this button will create a new one.  

New Plot creates a new verification plot with the data you have selected. All 
verification plots will be updated when you change the load step.  

 

4.7 The Result Menu 

4.7.1 Fringes 

Turns the display of fringes on/off. If you haven’t chosen any results from the 
results window, this item will be grayed out. 

4.7.2 Fringe range… 
Shows the dialog for setting the fringe range. The fringe range is automatically 

set when you choose a result, but if you want to override those settings, you can 
do it in this dialog. The fringe range will be reset to an automatic value when you 
chose a new result. 

4.7.3 Displacements 
Turns displacements on/off. Displacements are turned on by default.  

4.7.4 Displacement Scaling… 
This dialog lets you exaggerate or understate the displacements. A scaling factor 
of 1 means normal displacements. A value less than 1 will make the 

displacements smaller, and a value over 1 will make the displacements larger.  
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4.7.5 Step Range… 
Opens a dialog that lets you set the step range. By default, all steps are available, 

but this dialog gives you the opportunity to focus on a sub range of steps. When a 
sub range is selected, only steps from the sub range are shown in the plots and 

included in animations. 
 

 

4.7.6 Eigenmodes… 

 
In this dialog you can set up a simple animation of a model’s eigenmodes. A list 

of available eigenmodes will be displayed. Just chose what eigenperiod you want 
to animate, and the number of steps you want to animate over. The graphics 

window will show an animation with the input you chose. To end an eigenmode-
animation, just chose another load step. If no eigenmodes are available on your 
analysis file, the menu item will be unavailable.  

4.7.7 Animate 
Sets up a simple animation over all steps in the 

analysis file. The current result, if any, will be 
shown for all steps. An animation control 

appears, and from there you can play the 
animation forwards and backwards. Step 
forwards and backwards and set the current 

frame rate. To stop the animation, just choose a 
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step in the control plot. The animation control will only be available when an 
animation is running. 

4.7.8 Save Animation to File… 
If an animation has been set up, this menu item is available and selecting it opens 

a dialog that lets you save the current animation to an AVI, MPEG, or Animated 
GIF file. The dialog is shown in the following figure.  
 

 
 
The dialog may seem a bit complex at first glance, but there are different settings 

for the different file formats. Settings that are irrelevant for the selected format 
are disabled. In the figure you can see that AVI settings are enabled but MPEG 
settings and Animated GIF settings are disabled. 

 

AVI settings 

Note that you must select a compression format (“codec”) when you export to an 
AVI file. Some compression formats come with Windows but you may also have 

installed 3rd party codecs explicitly or indirectly via other software. Note that if 
you are using a non-standard codec you may be unable to play the AVI file on a 

different computer (unless the codec is installed on it). If you want to be safe, 
export the frames uncompressed. This results in large files but you will be able to 
play them no matter what, and the quality is perfect since there is no compression. 

Such an AVI file can usually be compressed to a much smaller .zip file.  
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Frame rate may be set to specify the rate to use when playing back the 
saved AVI file. Color depth may be specified to vary between 8, 16, and 

24 bits implying increased image quality but also increased storage 
requirements, loading time etc. 

 
MPEG settings  

Compression and quality parameters. The options Frames in GOP, P-frame 
distance and Target bit rate are expert options. If experimenting, first try to 

change the setting of Target bit rate.  

Frames in GOP Frames in each MPEG group of pictures (encoding 
pattern). 

Target bit rate Target bit rate of MPEG stream in bits/sec. A low bit rate 
implies high compression (and possible lower quality).  

P-frame distance Distance between P-frames in MPEG encoding pattern.  
 

GIF settings 

Settings for animated GIF output. 

Loop # of times specifies the number of times the saved animated GIF 

sequence is to be repeated. Checking the “Loop forever” box causes the 
GIF sequence to repeat indefinitely.  

Frame rate may be set to specify the rate to use when running the 
resulting animation from the saved file.  

Transparent: When this box is checked the GIF is generated with 
transparent background color, selectable via the “Transparent color” 

combo box. 
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4.7.9 Dynamic Plot… 

Shows a dialog that lets you display the 
dynamic plots available on the current 

model. Pick the plot you want to show, and 
chose if you want to show it in the time-
domain or frequency domain.  

Update Plot updates your current dynamic 
plot if you have any. If you don’t it will 

create a new one for you. 
New Plot creates a new plot with the input 
you have selected. 

If no dynamic plots are available on your 
analysis, this item will be unavailable.  

 
 
 

 
 

4.7.10 History Plot… 
Lets you create a history plot. You have to choose parameters for both x-axis and 

y-axis. There are two tabs in the dialog, one for both axes. The manner in witch 
input values are selected is identical for the two axes.  
A list of available plots is shown. 

The list is organized in Global, 
Element and Node plots. For each 
plot in the list, there may be a 

number of additional input 
parameters you need to supply. 

If a plot needs an element or node 
id, the input box for this will be 
opened. The same goes for End 

and DOF.  
Element and Node Ids can be 

typed in manually, or you can pick 
them from the model. Press the 
Aim-icon in the dialog, and you 

can pick element id and end, or 
node id from the model by holding 

down CTRL and left clicking on 
the model. 
Chose input parameters for both 

axis and press either Update Plot 
or New Plot. 
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Update Plot updates the current history plot. NB! If you haven’t created any 
history plot, your control plot will be updated. 

New Plot creates a new history plot with the input parameters chosen.  

4.7.11 Material Plot… 

 
 
The material Plot dialog lets you create a Material Model plot. You can type the 
Element ID and Element End you want the plot to represent. As in all dialogs 

requiring Element IDs, you can press the Aim-button and pick an Element from 
the model by pressing CTRL and left clicking with your mouse on the element 

you want. 
You also need to specify the force of both the x- and y-axis. The default selection 
is Y Moment for the x-axis, and X Force for the y-axis. 

New plot creates a new plot with the chosen input parameters.  
Update Plot updates the current Material Plot. If no Material Plot exists, it creates 

a new one. 

4.7.12 Start Logging Plot Commands… 

Opens a file dialog where you may specify the name of an USFOS Script File 
(.usf). All commands that have been run manually (through the command 
window) or indirectly via actions in the graphical user interface are logged to the 

file until you stop logging commands. This is very useful if you want to create 
plots for a number of result files. Just open the first file and start logging 

commands before performing the plot actions. When you’re done, stop the 
command logging. Then you may open the next result file and open and run the 
USFOS Script File you created. Then repeat this for the remaining result files. 

See the next section. 
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4.7.13 Stop Logging Plot Commands 
See the previous section. Stops logging commands to file if command logging is 

activated. The USFOS Script File being logged to will be closed and can now be 
opened so that the commands in it will be run in sequence. See the next section.  

4.7.14 Run Script File… 
Opens a file dialog where you may select and open an USFOS Script File (.usf). 

All commands in the file will be run in sequence. See the previous section. 
 

4.8 The Analysis Menu 

4.8.1 USFOS Analysis Setup… 
Opens the USFOS Analysis Setup Dialog. This d ialog makes it easier to start the 

definition of input for the analysis from scratch by helping to provide a minimum 
of what is needed. The contents of the dialog may be stored in an USFOS Setup 
File (.uss) so that it can be used in a later session.  

 
For more details, see section 3.3.3. 

4.8.2 USFOS Analysis Control… 
Opens the USFOS Analysis Control Dialog. This dialog makes it possible to edit 

input files, and to run an USFOS analysis. For a brief introduction illustrated by 
an example, see section 3.3.4. A more detailed description is given here.  
 

The Analysis Control Dialog looks as illustrated by the following figure.  
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The upper part of the dialog contains edit controls where names of the input files 
and the result file should be given. They may be given manually or the 

corresponding browse buttons ([…]) may be clicked to bring up file dialogs for 
specification of file names. The name “res” will be suggested as name of the 
result file by default, which means that the results will be written to a file called 

“res.raf”. 
 

The middle part of the dialog contains USFOS editors (see section 4.2.8 ) for the 
input files (control file, model file and optional file). Once a filename has been 
given, clicking the corresponding “Edit” button will open the input file in the 

corresponding USFOS editor, and the input file may be edited and saved, perhaps 
to a different filename, before running an analysis. The “Save As…”, “Save”, and 

“Close” buttons act on the currently active editor, which is determined by the 
selected tab. 
 

If there are no input files yet, they may be created from scratch with the USFOS 
editors. Just click “Edit”, and the corresponding editor will be activated. Just click 

“Save” when the input file is ready. If no name has been given for the input file, a 
file dialog will ask for a filename and the filename will appear in the 
corresponding edit control after the file has been saved.  
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When the input file(s) have been specified, an analysis may be run. Just click the 
“Run” button, and USFOS will be started with the given input file(s) as input. 

The amount of memory (in number of million words) to be used by USFOS for 
the analysis may be specified using the spin button in the bottom. 

 
Standard output from the analysis process is shown in the output window in the 
lower part of the dialog. This window may be hidden to make more space for the 

USFOS editors by unchecking the “Output” check button. This is also the case for 
the editors, which may be hidden by unchecking the “Editors” check button. Also 

note that the splitter control (thin horizontal bar) between the editors and the 
output window can be clicked and dragged vertically to change the heights of the 
editors and the output window. 

 
If  the analysis needs additional input from the user, the contents of the 

“Command line” control is sent to the standard input of the analysis process when 
“Apply” is clicked or the RETURN key is pressed.  
 

The analysis process may be aborted by clicking the “Abort” button. When the 
analysis process is finished, Xact will load the result file automatically.  

 
There is a check button called “Always on top”. If it is checked, this dialog will 
always be on top of the main window. If it is unchecked, click ing in the main 

window will bring the main window in front of this dialog. If the “Open *.out 
file” check button is checked, the .out file corresponding to the .res file will be 

opened in the internal editor and displayed when the analysis process is finished. 
This may be useful if something goes wrong during the analysis. The .out file 
may indicate what the problem is.  

4.8.3 FAHTS Analysis Control… 
Opens the FAHTS Analysis Control Dialog. This dialog makes it possible to edit 

input files, and to run a FAHTS analysis. The dialog is identical to the USFOS 
Analysis Control Dialog, except for the fact that it runs FAHTS instead of 
USFOS, and that “optional” files are called “KFX files”. See section  4.8.2 for 

more information. 

4.8.4 STRUMAN Analysis Control… 

Opens the STRUMAN Analysis Control Dialog. This dialog lets you edit input 
files and run a STRUMAN analysis. The dialog is identical to the USFOS 
Analysis Control Dialog, except for the fact that it runs STRUMAN  instead of 

USFOS. See section  4.8.2 for more information. 
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4.9 The Window Menu 

4.9.1 Animation Control 

Here you can turn the display of the animation control on or off. Remember that 
the animation control is unavailable when no current animation is running.  

4.9.2 Command Window 
Turns the display of the Xact Command Window on/off. For a listing of available 

commands, see Appendix A, Quick Command Reference.  

4.10 The Help Menu 

4.10.1 About 

Shows information like version numbers etc.  

4.10.2 USFOS Input Commands… 

Shows the on- line documentation of the USFOS input commands. 

4.10.3 Graphical User Interface… 

Shows the on- line documentation of the graphical user interface (this document).  
 

4.11 The File Toolbar 

 

4.11.1 Open 
See Open File in The File Menu section.  

4.11.2 Save Scene 
See Save Scene in The File Menu section.  

4.11.3 Print Scene 

See Print in The File Menu section.  

4.11.4 Print Current Plot 

See Print in The File Menu section.  

4.11.5 Select Region 

Activates/deactivates “Select Region” mode. See 4.3.15. 
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4.12 The Misc. Toolbar 

 

4.12.1 Clip 
See Clip… in The Edit Menu section 

4.12.2 Eigenmodes 
See Eigenmodes…in The Result Menu section 

4.12.3 Set up Animation 
See Animate… in The Result Menu section 

4.12.4 Animation Control 

See Animation Control… in The Window Menu section 

4.12.5 Command Window 

See Command Window… in The Window Menu section 
 

4.13 The Display Toolbar 

 

4.13.1 Show as Surface 
See Show as surface in The Display Menu Section 

4.13.2 Show as Lines 
See Show as lines in The Display Menu Section 

4.13.3 Show as Points 
See Show as points in The Display Menu Section 

4.13.4 Show as Outline 
See Show as outline in The Display Menu section 

4.13.5 Show as Hidden Lines 

See Show as hidden lines in The Display Menu section 
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4.14 The Plots Toolbar 

 

4.14.1 Verification 
See Verification Plot in The Verify Menu section. 

4.14.2 History 
See History Plot in The Result Menu section 

4.14.3 Dynamic 
See Dynamic Plot in The Result Menu section 

4.14.4 Material Model 

See Material Plot in The Result Menu section.  
 

4.15 The View Toolbar 

 

4.15.1 Zoom 
The rubberband zoom. When you toggle this button, you can zoom in on a part of 

the model. Just left click and hold the mouse button down in the graphics view. 
You will begin to draw a rectangle. When you release the mouse button, the view 
will zoom in to the area in the rectangle. A small rectangle zooms with a great 

magnitude, and a large rectangle zooms in with less magnitude.  

4.15.2 Zoom Out 

Zooms out with a preset factor.  

4.15.3 Zoom In 

Zooms in with a preset factor.  

4.15.4 Frame 
Zooms in or out to fit the whole model in the view.  

4.15.5 Isometric View 
Sets the view to look at the model with origo in the center of the screen.  

4.15.6 View From Z-axis 
Views the model from the Z-axis. Straight on the XY-plane. 
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4.15.7 Set Rotation Point 
Sets the rotation point once you have clicked the left mouse button while pointing 

at a position of your choice in the model. The model will now rotate around this 
point when you navigate. 

4.15.8 Automatic Rotation Point 
Sets the rotation point automatically. This means that the model will rotate around 

the center of the model’s bounding box when you navigate. This is default.  

4.15.9 Show Rotation Point 
Toggles display of the rotation point, which is shown as a light gray sphere. 

Display of the rotation point is switched off by default.  
 

4.16 The Navigate Toolbar 

 

4.16.1 Rotate Up 

Rotates the model 22,5 degrees upwards 

4.16.2 Rotate Down 
Rotates the model 22,5 degrees downwards 

4.16.3 Rotate Right 
Rotates the model 22,5 degrees right 

4.16.4 Rotate Left 
Rotates the model 22,5 degrees left 

4.16.5 Rotate Clockwise 
Rotates the model 22,5 degrees clockwise 

4.16.6 Rotate Counter-clockwise 

Rotates the model 22,5 degrees counter clockwise 

4.16.7 Perspective 

Toggles between perspective and parallel projection. Perspective is default.  



Appendix A 

Quick Command Reference 

Required parameters are given inside brackets like this:  <parameter>. Optional parameters given inside square brackets, like 
this [optional parameter]. When you need to choose one of several options for a parameter the options are divided by a pipe 

like this: [on|off]. 
 
Commands   Parameters    Description 

 
File commands  

open    <file name>     Open .raf file, .fem file, or open as text file in editor 
open raf    <file name>     Open .raf file 
open fem    <file name>     Open .fem file 

print plot         Print current plot 
save viewattributes   <file name>     Save view attributes to file  

load viewattributes   <file name>     Load view attributes from file 
load labels    <file name>     Load user-defined labels from file 
 

Display commands 

 

display hiddenlines    [<from part>, <to part>]   Show parts as hidden lines 
display surface   [<from part>, <to part>]  Show parts as surface 
display lines    [<from part>, <to part>]  Show parts as lines 

display points    [<from part>, <to part>]  Show parts as points 
display outline   [<from part>, <to part>]  Show parts as outline 
display hide    [<from part>, <to part>]  Hide parts 

display legend   [on | off]    Toggle or set display of legend 
display elementnumbers  [on | off]     Toggle or set display of master element numbers 
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display nodenumbers  [on | off]     Toggle or set display of master node numbers 
display highlightelement  <element ID> | none    Highlight master element or turn off highlighting 

display highlightnode  <node ID> | none    Highlight master node or turn off highlighting 
display mesh    [on | off]     Toggle or set display of mesh 
display bgcolor   <r, g, b>     Set background color 

display meshcolor   <r, g, b>     Set mesh color 
display partcolor   <r, g, b> [<from part>, <to part>]  Set part color 

 
Navigation commands  

 

rotate right    [<degrees>]     Rotate view to the right 
rotate left    [<degrees>]    Rotate view to the left 

rotate up    [<degrees>]    Rotate view up 
rotate down    [<degrees>]    Rotate view down 
rotate clockwise   [<degrees>]    Rotate view clockwise 

rotate counter clockwise [<degrees>]    Rotate view counter clockwise 
rotate setdefault   <degrees>     Set default rotation angle 

zoom in    [<factor>]     Zoom in 
zoom out    [<factor>]     Zoom out 
zoom frame         Zoom model to fit frame 

zoom setdefault   <factor>     Set default zoom factor 
view from x         View model from x-axis 

view from –x         View model from negative x-axis 
view from y         View model from y-axis 
view from –y         View model from negative y-axis 

view from z         View model from z-axis 
view from –z         View model from negative z-axis 

view isometric 1        View model from 1st octant 
view isometric 2        View model from 2nd octant 
view isometric 3        View model from 3rd octant 

view isometric 4        View model from 4th octant 
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view isometric 5        View model from 5th octant 
view isometric 6        View model from 6th octant 

view isometric 7        View model from 7th octant 
view isometric 8        View model from 8th octant 
perspective on        Use perspective projection 

perspective off        Use parallel projection 
 

Results commands  

 
results step    <step number>    Select step 

results steprange   <from>, <to>     Set step range 
results showfringes   [on | off]     Toggle or set display of fringes 

results fringe    <1st name>, <2nd name>, 
<3rd name> [,<4th name>]   Select fringe result 
 

results fringerange   <from>, <to>     Set fringe range 
results bar   <1st name>, <2nd name>, 

 <3rd name> [,<4th name>]  Select bar result 
results showbars  [on | off]    Toggle or set display of bars 
results vector   <1st name>, <2nd name>, 

 <3rd name> [,<4th name>]  Select vector result 
results showvectors  [on | off]    Toggle or set display of vectors 

results displacements   [on | off]     Toggle or set displacements 
results scaledisplacements  <factor>     Scale displacements 
results list eigenperiods       List eigen periods 

results modeshape   <eigen period index> [steps]   Set up mode shape animation for eigenperiod 
results animate 

 
Animation commands 

 

anim play         Play animation 
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anim stop         Stop animation 
anim pause         Pause animation 

anim playbackward        Play animation backward 
anim stepforward        Step animation forward 
anim stepbackward        Step animation backward 

anim maxfps    <fps>      Set maximum number of frames per second 
 

Plot commands 

plot history   <x-name | x-number>, <x-item>, 
<x-end | x-int.sec>, 

<x-dof | x- int.pnt>, 
<y-name | y-number>, <y-item>, 

<y-end | y-int.sec>, 
<y-dof | y- int.pnt>   Create history plot 
 

plot dynamic    <name | number> [freq]  Create dynamic plot 
plot materialmodel  <name | number>, <element ID>, 

<element end>, <x-dof>, <y-dof> Create material model plot 
plot verification   <name | number>, <node ID>, 

<x-dof>    Create verification plot 

plot list history        List available history plots  
plot list dynamic        List available dynamic plots 

plot list materialmodel       List available material model plots 
plot list verification        List available verification plots 
plot save   <filename>, <file type>  Save plot as image to file 

plot savedata   <filename>    Save plot data to text file 
     

Set commands 

 
set colors    [on | off]     Turn display of set colors on or off 

set list          List available sets 
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set show    [ID]      Show set given by ID. -1 means all 
set hide    [ID]      Hide set given by ID. -1 means all 

set entiremodel        Show the entire model 
 
Clip commands 

 
clip add    <element ID>     Add element to clipped model 

clip remove    <element ID>     Clip away element 
clip undo elementremove       Undo last element removal 
clip reset         Reset clipping 

clip showcomplement       Show the complement of the clipped model 
clip showclipped        Show the clipped model 

 
Export commands 

 

export vtf    <filename>, [current | all]   Export current or all steps to VTF file. Default is all 
 

Misc commands  

 
verify node    <ID>      Display verification info for node 

verify element   <ID>      Display verification info for element 
verify general    <text info ID>, <element ID>, 

<end>, <node ID>, <DOF>, 
<group ID>    Display general verification info 

quit         Close the application



Appendix B 

USFOS Label File Format (.usl) 

This file type is an ASCII text file containing user-defined labels for nodes and/or 
elements. This is useful if you want to add textual information to specific parts of 

the model. The sections Read Labels From File… and Labels… describe how to 
read user-defined labels from file and how to manipulate the labels.  

 
The file contains one block per label group. A label group may contain any 
number of element labels and/or any number of node labels. The format is as 

follows: 
 
BeginLabel 

 

Heading  <name of label group> 

 

ElementLabel <element ID> <label text>                

ElementLabel <element ID> <label text> 

[..] 

ElementLabel <element ID> <label text> 

 

NodeLabel <node ID> <label text> 

NodeLabel <node ID> <label text> 

[..] 

NodeLabel <node ID> <label text> 

 

EndLabel 

 
Example: 

 
#                                       - First Label Set 

# 

BeginLabel 

Heading    Model Overview 

# 

#            ElemID      Label Text 

ElementLabel     1        Guide Pin                

ElementLabel 20573        South                    

ElementLabel 21120        North 

ElementLabel 20846        East  

ElementLabel 21387        West 

# 

"            NodeID      Label Text 

NodeLabel        1        Elevation  4.520 

NodeLabel    13955        Elevation -1.710 

 

EndLabel 

 

#                                       - 2'nd  Label Set 

# 

BeginLabel 

Heading    Inspection Summer 2004 

# 

#            ElemID      Label Text 

ElementLabel 20738        Excellent Weld    

ElementLabel 20788        Normal Weld     

# 

#            NodeID      Label Text 

NodeLabel    52286       Gasket Renewed    

 

EndLabel 
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USFOS Utility Configuration File (“Xact_Utils.usc”) 
If the file “Xact_Utils.usc” is present in the same directory as the USFOS GUI 

executable when USFOS GUI is launched, information about available utilities 
will be read on startup. If the file contains valid information about utilities, the 

File menu will have a sub menu called “Run Utility” from which you may launch 
utilities, and a menu item called “Utilities…”, which brings up a dialog 
containing a list of the utilities and optionally descriptions of the utilities and 

hyperlinks to user manuals. 
 

The file contains one block per utility. The format is as follows: 
 
BeginUtilityTool 

ProgramName <program name> 

ProgramFile <executable> 

Manual  <name of manual file> 

Description <description line 1> 

Description <description line 2> 

[…] 

Description <description line N> 

Parameter <default parameter> 

ParameterInfo <parameter description line 1> 

ParameterInfo <parameter description line 2> 

[…] 

ParameterInfo <parameter description line N> 

 
Example: 
 

BeginUtilityTool 

ProgramName             StruMan 

ProgramFile             struman.exe 

Manual                  struman.pdf 

Description             Model File Conversion, 

Description             Unit Conversion, Model Manipulation, etc.  

Description             NOTE! Unsupported utility Software.  

ParameterInfo           Specify memory size. 

ParameterInfo           Default memory (30 million words). 

EndUtilityTool 

 

BeginUtilityTool 

ProgramName             Soil 

ProgramFile             soil.exe 

Manual                   

Description             Gensod data to Usfos.  

Description             NOTE! Unsupported utility Software.  

EndUtilityTool 

 

 

USFOS Script File (.usf) 

Files of this type are simply ASCII files containing commands (see Quick 
Command Reference). One line can contain only one command (with parameters) 
and a command can’t be distributed over several lines.  

 
Such files can be written manually or generated automatically through command 

logging (see Start Logging Plot Commands…). USFOS Script Files can be 
opened and run. For more information, see Run Script File…. 
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